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NOTE: This device complies with Part 15 of the FCC Rules. Operation is subject to 
the following two conditions: (1) this device may not cause harmful interference 
and (2) this device must accept any interference received, including interference 
that may cause undesired operation. 

NOTE: This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to 
cause harmful interference in which case the user will be required to correct the 
interference at their expense. 

 
Changes or modifications not expressly approved by Kapsch 
TrafficCom Canada Inc. could void FCC compliance and the authority 
to operate the equipment. 

 

NOTE: IEC 60950-1 and/or EN60950-1, First Edition, Information Technology 
Equipment – Safety – Part 1: General Requirements require that this equipment 
must be located in a RESTRICTED ACCESS LOCATION (RAL). Only authorized 
personnel can have access to the equipment.  
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FACTORY SUPPORT SERVICE 
For Return Material Authorization (RMA) numbers please telephone: 905 624-3020. 

For service information and other requests please FAX: 905 625-6197. 

NOTICE 
The information presented in this document is current although it is subject to 

change. As such, Kapsch TrafficCom Canada Inc. assumes no liability on behalf of 
the USER with respect to interpretation based on the use of this information 

Kapsch TrafficCom Canada Inc.   ©2022 

COPYRIGHT STATEMENT 

These drawings and specifications contain confidential and proprietary 
information and are the property of  

KAPSCH TRAFFICCOM CANADA INC. 

and are issued in strict confidence and will be kept confidential and used solely 
for the purpose intended and for no other purpose and shall not be transmitted, 

reproduced, copied, and/or used as the basis for manufacture or sale of 
apparatus unless otherwise agreed to in writing by Kapsch TrafficCom Canada 

Inc. 
 

IMPORTANT! 
NOTICE OF PATENTS: 

Kapsch TrafficCom Canada Inc. 
has patented or has patents pending on critical design features of the item or items 
described herein. Contact the CTO at the address and phone number stated on the 

front page for all queries on patents. 
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1. ABOUT THIS MANUAL 
This guide provides instructions on how to install and operate the T600 Tag Tester for testing Kapsch TrafficCom Canada Inc. 
On Board Units (OBUs), also referred to as tags. 

Kapsch TrafficCom Canada Inc. supplies the T600 Tag Tester. This manual is divided into two parts; Operator Instructions and 
Maintenance Instructions. See the Table of Contents for more details. 

This manual is the main reference document used during training given by Kapsch TrafficCom Canada Inc. to operator, 
installation and maintenance personnel. These personnel should be proficient in using the Windows operating system. 
Additionally, installation and maintenance personnel must be able to configure the customer-supplied computer serial 
ports. This manual is also used as a reference by Kapsch-certified technical service personnel in the field once training has been 
completed. 

Note: The terms OBU and tag are used interchangeably in the manual. 

Warnings and Cautions 

Warnings 

Warnings indicate a risk of bodily harm and include a symbol indicating the type of injury that is at risk.  

 

WARNING: 
 WARNING DESCRIPTION HERE. 
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The following warnings appear in the manual:  

 

DO NOT STARE DIRECTLY AT THE LASER BEAM OR ANY SECONDARY 
REFLECTIONS EMITTING FROM THE INTERNAL TTU BAR CODE SCANNER. 
LASER LIGHT CAN CAUSE EYE INJURY AFTER PROLONGED EXPOSURE. THE 
INTERNAL TTU BAR CODE SCANNER EMITS CLASS 2 LASER LIGHT. 

 

DO NOT STARE DIRECTLY AT THE LASER BEAM EMITTING FROM THE HAND-
HELD BAR CODE SCANNER. LASER LIGHT CAN CAUSE EYE INJURY AFTER 
PROLONGED EXPOSURE. THE HAND-HELD BAR CODE SCANNER IS A CLASS 2 
LASER PRODUCT. 

Cautions 

Cautions indicate a risk of damage to equipment or loss of data. 

 

CAUTION: 

Caution description here. 

The following caution appears in the manual: 

Ensure the OBUs are placed correctly in the TTU cradle. Operational OBUs could fail if not orientated correctly in the cradle. 
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OPERATING INSTRUCTIONS 
 

 

 

 

 

 

 

 

 

 

  



 

T600 Tag Tester 

DOC#: UM 360420-835 REVISION F  Page 14 of 55 

© Kapsch TrafficCom Canada Inc. 2022 
These drawings and specifications contain confidential and proprietary information and are the property of Kapsch TrafficCom Canada Inc. and are issued in strict confidence 
and will be kept confidential and used solely for the purpose intended and for no other purpose and shall not be transmitted, reproduced, copied, and/or used as the basis for 
manufacture or sale of apparatus unless otherwise agreed to in writing by Kapsch TrafficCom Canada Inc. 

 
FILE:UM 360420-835 REV F, T600 OPERATOR AND MAINTENANCE MANUAL.DOCX                                                                                                                     03/28/2022 3:02 

Kapsch TrafficCom 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This page intentionally left blank. 
 

 

 

 

 

 

 

 

 

 

 

 



 

T600 Tag Tester 

DOC#: UM 360420-835 REVISION F  Page 15 of 55 

© Kapsch TrafficCom Canada Inc. 2022 
These drawings and specifications contain confidential and proprietary information and are the property of Kapsch TrafficCom Canada Inc. and are issued in strict confidence 
and will be kept confidential and used solely for the purpose intended and for no other purpose and shall not be transmitted, reproduced, copied, and/or used as the basis for 
manufacture or sale of apparatus unless otherwise agreed to in writing by Kapsch TrafficCom Canada Inc. 

 
FILE:UM 360420-835 REV F, T600 OPERATOR AND MAINTENANCE MANUAL.DOCX                                                                                                                     03/28/2022 3:02 

Kapsch TrafficCom 

2. OVERVIEW 

Introduction 

The T600 Tag Tester Unit (TTU) ensures OBUs are functioning properly by testing at what RF signal levels the OBU can 
reliably send and receive RF signals.  

T600 system components 

• a T600 Tag Tester Unit (TTU), with external power supply 

• a serial null-modem cable 

• a serial scanner cable 

• a T600 software Installation CD 

• Optional: Calibration files 

• Optional: a Hand-held bar code scanner 

Figure 2-1: T600 Tag Tester System Components 

customer-supplied 
computer running 
Kapsch-supplied 
T600 software

optional hand-held 
bar code scanner

Tag Tester Unit 
(TTU)
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T600 Tag Tester Unit (TTU) 

The T600 has two RF channels each set to different power levels required to support communication with various 
Kapsch TrafficCom Canada Inc. OBUs. 

The T600 TTU antenna located under the tag cradle communicates with OBUs placed in the cradle during testing. A 
test can only be initiated after a proximity sensor located in the cradle detects the presence of an OBU. A bar code 
scanner located inside the T600 reads the serial number printed on the OBU label, while an optional external hand-
held bar code scanner may be used for the same purpose.  

TTU antenna 

The antenna is located underneath the OBU cradle.  

TTU OBU cradle 

The cradle is shaped to ensure the various OBUs are positioned correctly in the TTU. OBUs must be correctly 
orientated in the cradle to achieve accurate test results (see ‘Note: Correct orientation of the G4 OBUs in the TTU 
cradle’, page 50). 

 

Figure 2-2: Tag Tester Unit (TTU) - Front View 
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Figure 2-3: Tag Tester Unit (TTU) - Rear View 

 

T600 software 

A customer-supplied computer running the T600 software provides the user interface for the TTU via an RS-232 
communications link.  

The user interface shows the user interface nomenclature used throughout the manual and the location of the Tag 
Pass message.  

Figure 2-5 shows the location of the tag failure messages. 
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Figure 2-4: Tag Pass Message 

 

 

Figure 2-5: Tag Failure Message 
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How the T600 Tag Tester works 

The T600 tests OBUs by determining the RF signal strength required to successfully and consistently communicate 
with a given OBU.  

The T600 begins the test by sending out an RF signal at the maximum attenuation level (15 dB). The T600 then waits 
for a response from the OBU. If the T600 does not receive a response from the OBU, the T600 decreased the 
attenuation by 1 dB (thereby increasing the signal strength) and repeats the process. The T600 continues this process 
until a successful read occurs or a response is not received from the OBU at the maximum signal level (0dB). 

If the RF signal level required to communicate with an OBU is not within the acceptable limits, the OBU fails the test. 
Contact Kapsch TrafficCom Canada Inc. to arrange an RMA so the OBU can be returned. 

The T600 scans the bar code on the OBU to confirm the OBU’s identity. If the bar code data does not match the data 
in the OBU, the OBU fails the test.  

The test results 

 For a tag to pass the test, the following conditions must be met.  

• The Read margin is within tolerance. 

• The Write margin is within tolerance. 

• The Read results are within tolerance. 

• The Write results are within tolerance. 

• The barcode ID must match the transponder serial number. 

Margin results 

The Margin Read value is the dB level that results in consecutive reads of the OBU, whereas the Margin Write is the dB 
level that results in consecutive writes to the OBU. Any Read or Write value outside of the acceptable dB range results 
in a tag failure. 

Correct tag data 

The T600 also checks to confirm that the OBU contains the correct data (correct tag type, correct Agency ID, etc.). If 
this information is incorrect, the OBU fails. 
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T600 Tag Tester communication functional blocks 

Figure 2-6 illustrates the communication interfaces of the T600 Tag Tester system. 

Figure 2-6: T600 Tag Tester Communication Block Diagram 

serial port USB port*

user-supplied computer

* several options are available 
for connecting the hand-held 
bar code scanner to the computer

serial port

Tag Tester Unit (TTU) optional hand-held 
barcode scanner

HOST port SCANNER port

internal bar 
code scanner
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3. OPERATING PROCEDURES 

Starting up the T600 tag tester 

The T600 Tag Tester start up procedure involves turning on the Tag Tester Unit (TTU) and launching the  
T600 software application. 

Prerequisites: You must first install the T600 software and hardware. 
Contact Kapsch TrafficCom for the latest agency mapping file (see page 39 for upgrading mapping file 
procedure). 

 Set the power switch on the back of the TTU to the on position. The TEST IN PROGRESS LED illuminates solid red 
for a few seconds. 

 Launch the T600 PC software as Administrator by right-clicking T600TagTester.exe on the customer-supplied 
computer and select Run as administrator option. You are now ready to test OBUs. 

Testing a tag 

Testing a tag involves correctly orienting the OBU in the cradle of the TTU and manually initiating testing. The T600 tag 
tester then automatically conducts the various tests. 

Prerequisites: -  You must maintain a minimum of 1ft. between the TTU and OBUs not being tested. 
 - You must first enter text in the User/Comment box. 

 

CAUTION: 

Ensure the OBUs are placed correctly in the TTU cradle. Operational OBUs could fail if 
not oriented correctly in the cradle. 

 Place the OBU in the TTU cradle. Ensure the OBU is properly aligned (see’ Note: Correct orientation of the G4 
OBUs in the TTU cradle’, page 50). 

 Remove your hand from the T600 test chamber. 

 

  

 

WARNING: 

DO NOT STARE DIRECTLY AT THE LASER BEAM OR ANY SECONDARY 
REFLECTIONS EMITTING FROM THE INTERNAL TTU BAR CODE SCANNER. 
LASER LIGHT CAN CAUSE EYE INJURY AFTER PROLONGED EXPOSURE. THE 
INTERNAL TTU BAR CODE SCANNER EMITS CLASS 2 LASER LIGHT. 
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NOTE: Do not move or remove the OBU while the test is in progress. The test aborts if 
the proximity sensor cannot detect the OBU in the TTU cradle. 

 Click Test Start or press CTRL+A to begin testing. The Test in Progress message displays on the user interface and 
the TEST IN PROGRESS LED on the front of the TTU illuminates red.  

 If the T600 cannot read or recognize the OBU data and the internal bar code scanner cannot read the OBU bar 
code, you are prompted to manually enter the bar code number (see ‘Entering the OBU bar code number’, page 
22). You cannot proceed until you enter a valid bar code number. 

 After a few seconds, testing completes and the test result displays at the bottom of the T600 user interface. 
Remove the OBU from the TTU. The T600 Tag Tester is ready to test the next OBU. 

 If the OBU fails the tag test, contact Kapsch TrafficCom Canada Inc. to arrange an RMA so the OBU can be 
returned. 

Entering the OBU bar code number 

If the TTU cannot read or recognize an OBU in its cradle during testing, it scans the OBU bar code. If the TTU cannot 
scan the OBU bar code, you must manually enter the bar code information or scan the OBU bar code with the optional 
hand-held scanner. 

Prerequisites: - The Transponder Bar Code Label window (Figure 3-1) is active. 
 - To use the optional hand-held bar code scanner, the scanner must be installed according to the 

manufacturer’s instructions. 

 Remove the OBU from the TTU cradle.  

 

WARNING: 

DO NOT STARE DIRECTLY AT THE LASER BEAM EMITTING FROM THE HAND-
HELD BAR CODE SCANNER. LASER LIGHT CAN CAUSE EYE INJURY AFTER 
PROLONGED EXPOSURE. THE HAND-HELD BAR CODE SCANNER IS A CLASS 2 
LASER PRODUCT. 

 If the optional hand-held bar code scanner is installed, scan the OBU bar code. 

 If the optional hand-held scanner is not installed or it cannot scan the bar code, use the customer-supplied 
computer keyboard to enter the number on the bar code label in the Transponder Barcode Label dialog box 
(Figure 3-1). You cannot proceed until you enter a valid bar code number. 

 Once the bar code number has been entered, the test results are displayed on the user interface. 
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Figure 3-1: The Transponder Barcode Label Window. 
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Understanding the T600 test data 

A variety of information about the OBU is displayed in the Test Results area after a test.  

Table 3-1: Burst Test Read Results Explained 

Read Result field Information displayed 

Successes The number of successful reads during the burst test. 

Fail CRC The number of reads that failed as a result of a bad CRC. 

Fail timeout The number of reads that failed as a result of an OBU not 
communicating within the allowable time. 

Table 3-2: Burst Test Write Results Explained 

Write Result field  Information displayed 

Successes The number of successful writes during the burst test. 

Fail CRC The number of writes that failed as a result of a bad CRC. 

Fail timeout The number of writes that failed as a result of an OBU not 
communicating within the allowable time. 

Fail verify The number of writes that failed because a successful write could 
not be confirmed. 

Table 3-3: Margin Test Results Explained 

Margin field  Information displayed 

Read The attenuation value, between 0 and 15 dB, that allows the OBU to 
be read successfully.  

Write The attenuation value, between 0 and 15 dB, that allows the OBU to 
be written to successfully. 
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Configuring log files 

The T600 can be configured to record all OBU tests or just OBU tests that result in a failure. These records are added 
to a user-specified log file. 

Prerequisites: None. 

 From the Log File information area of the T600 software interface, enter your user information (e.g. your user ID) 
in the User/Comment box. This information appears in each log file record. 

 If you want records for every OBU test, clear the Log only failed tests check box. 

 If you want records only for OBU test failures, select the Log only failed tests check box. 

 If you want to record test results to the Log file displayed in the Log File field, no action is required. 

 If you want to specify a new log file: 

 Click on New Log file. 

 Select the text file you want to record test results to. Click Open. 

 If the text file does not yet exist, create the text file and repeat step b. 

 The new log file path is displayed in the Log File field of the Log File information area and is ready to 
record test results. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

T600 Tag Tester 

DOC#: UM 360420-835 REVISION F  Page 26 of 55 

© Kapsch TrafficCom Canada Inc. 2022 
These drawings and specifications contain confidential and proprietary information and are the property of Kapsch TrafficCom Canada Inc. and are issued in strict confidence 
and will be kept confidential and used solely for the purpose intended and for no other purpose and shall not be transmitted, reproduced, copied, and/or used as the basis for 
manufacture or sale of apparatus unless otherwise agreed to in writing by Kapsch TrafficCom Canada Inc. 

 
FILE:UM 360420-835 REV F, T600 OPERATOR AND MAINTENANCE MANUAL.DOCX                                                                                                                     03/28/2022 3:02 

Kapsch TrafficCom 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This page intentionally left blank. 
 
 
 
 
 



 

T600 Tag Tester 

 

 

DOC#: UM 360420-835 REVISION F Page 27 of 55 

© Kapsch TrafficCom Canada Inc. 2022 
These drawings and specifications contain confidential and proprietary information and are the property of Kapsch TrafficCom Canada Inc. and are issued in strict confidence and will be kept confidential and used solely for the purpose intended 
and for no other purpose and shall not be transmitted, reproduced, copied, and/or used as the basis for manufacture or sale of apparatus unless otherwise agreed to in writing by Kapsch TrafficCom Canada Inc. 
 
FILE: UM 360420-835 REV F, T600 OPERATOR AND MAINTENANCE MANUAL.DOCX                              03/28/2022 3:02 

Kapsch TrafficCom 

Command and Controls 

Command How is this command executed? Who can execute this 
command? 

What does this command do? What is the purpose of this 
command? 

Exit From the File drop-down menu,  
click Exit. 

anyone Closes the T600 Tag Tester 
software. 

To exit the T600 Tag Tester 
software. 
 

Serial Data 
Window 

From the Settings drop-down menu, 
click Serial Data Window.  

anyone Opens the Serial Data Window. To monitor data to and from 
the customer-supplied 
computer. 

Configuration From the Settings drop-down menu, 
click Configuration. 

anyone Opens the Configuration Dialog 
window. 

To access the T600 Tag Tester 
configuration settings. 
 

About T600 Tag 
Tester 

From the Help drop-down menu, 
click About T600 Tag Tester. 

anyone Opens the About T600 Tag 
Tester window. 

To view the T600 Tag Tester 
version information. 
 

Test Start Click on Test Start, 

or, 

press CTRL+A 

anyone Starts the margin and burst 
test. 

To initiate testing after an OBU 
has been placed in the TTU 
cradle. 
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Command How is this command executed? Who can execute this 
command? 

What does this command do? What is the purpose of this 
command? 

Test Stop Click on Test Stop, 

or, 

press CTRL+E 

anyone Stops the margin and burst test. To abort a test in progress. 

Calibrate Click on Calibrate, 

or, 

press CTRL+L 

anyone Opens the Calibration screen. 
(opens the TTU Serial Number 
tab in the Configuration 
window if a TTU serial number 
has not been entered). 

To access calibration functions. 

Ignore tag type 
mismatches for 
tags being 
calibrated 

Click on Calibrate, then, 
select the Ignore tag type mismatches 
for tags being created check box. 

 

Kapsch service personnel Allows results from one tag 
type to be used to calibrate a 
different tag type. 

To use the calibration 
parameters of one tag type to 
be used for another tag type. 

Clear calibration 
data 

Click on Calibrate, then, 
click on Clear calibration data. 

 

Kapsch service personnel Opens the Password window. To clear calibration data. 

Perform margin 
test 

Click on Calibrate, then, 
click on Perform margin test. 

Kapsch service personnel Opens the Password window. Starts the calibration margin 
test. 
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Command How is this command executed? Who can execute this 
command? 

What does this command do? What is the purpose of this 
command? 

Accept After a calibration margin test returns 
Read and Write dB values,  
click on Accept. 

Kapsch service personnel Accepts the calibration margin 
test results. 

To use the Read and Write 
calibration margin test results 
as the criteria for OBU tests of 
this type. 

New Log File Click on New Log File. anyone Opens the Open file window. To specify to which text file 
new log records are added. 

Log Only Failed 
Tests 

Select the Log Only Failed Tests check 
box. 

anyone Sets the T600 to only log tag 
failures to the log file. 

Enabled: to log only failed tag 
tests to the log file. 

Disabled: to log all tag tests to 
the log file. 

Comm. Port 
(T600) 

From the Communication tab in the 
Configuration Dialog window,  
select the computer COM port that is 
connected to the T600 HOST port from 
the T600 Comm. Port drop-down box, 
then, 

Click OK. 

anyone Establishes which computer 
COM port is connected to the 
T600 HOST port.  

To establish which computer 
COM port is connected to the 
HOST port. 
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Command How is this command executed? Who can execute this 
command? 

What does this command do? What is the purpose of this 
command? 

Baud Rate 
(T600) 

From the Communication tab in the 
Configuration Dialog window, 
select the baud rate for the computer 
COM port that is connected to the 
T600 HOST port from the T600 Comm. 
Port drop-down box, then, 
click OK. 
 

anyone Establishes the baud rate for 
communications between the 
customer-supplied computer 
and the TTU. 

To establish the HOST port 
baud rate. 

Comm. Port 
(Scanner) 

From Communication tab in the 
Configuration Dialog window,  
select the computer COM port that is 
connected to the T600 SCANNER port 
from the Scanner Comm. Port drop-
down box, then, 
click OK. 
 

anyone Establishes which computer 
COM port is connected to the 
T600 SCANNER port. 

To establish which computer 
COM port is connected to the 
internal T600 bar code 
scanner. 

TTU serial number From the TTU Serial Number tab in the 
Configuration Dialog window, 
enter the TTU serial number (found on 
the back of the TTU) in the TTU serial 
number box, then, 
click OK. 
 

anyone Establishes the TTU serial 
number. 

To ensure the computer is 
connected to the correct TTU. 

Also, if multiple calibration files 
are installed, to ensure the 
correct calibration file is used. 
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Command How is this command executed? Who can execute this 
command? 

What does this command do? What is the purpose of this 
command? 

Change 
configuration data 

From the T600 Tag Tester 
Configuration Tab in the Configuration 
window, 
click on Change configuration data. 

Kapsch service personnel Opens the Password window. To allow Kapsch TrafficCom 
Canada Inc. personnel to 
change the T600 configuration 
settings. 

Clear 
(serial data) 

From the Serial Data Dialog window, 
click on Clear from the File drop-down 
menu. 

anyone Clears the data in the Serial 
Data Dialog window. 

To discard old serial data so 
only the latest serial data is 
displayed. 

Save PDU data From the Serial Data Dialog window, 
click on Save PDU data from the File 
drop-down menu. 

anyone Opens the Save As window. To save a copy of the PDU data 
currently displayed in the Serial 
Data Dialog window. 

Freeze Screen From the Serial Data Dialog window, 
click on Freeze Screen from the File 
drop-down menu. 

anyone Prevents the Serial Data Dialog 
window from updating with 
new data. 

To prevent serial data from 
being overwritten so it can be 
examined. 
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MAINTENANCE INSTRUCTIONS 
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4. THEORY OF OPERATIONS 

This section offers more details on T600 tag testing and calibration than the introductory overview provided in the 
Overview on page 15.  

Calibration 

Calibration can only be performed by Kapsch service personnel. During calibration, a gold standard OBU is used to 
determine which margin levels are detected by that particular TTU. These margin levels then become the test criteria 
for that OBU type. OBUs fail the margin test if they give margin test results that fall outside the test criteria by +/- 2 
dB. 

The write tests 

Toll collection data and traffic management data is not overwritten during the margin and burst write tests. During a 
write test, the same data that was obtained during the read test is written back to the OBU. Additionally, a reserved 
memory bit is set to 1 during a write test. Because this bit is set to 0 at the factory, and this bit can only be changed by 
the T600, a value of 1 indicates the OBU has been successfully tested by a T600. 

The burst tests 

The burst tests ensure the OBU can be read and written to consistently. The TTU RF signal attenuation is decreased by 
3 db. The TTU then performs 50 reads and 50 writes. To pass the Read burst test, 90% of the 50 reads must be 
successful; to pass the Write burst test, 80% of the 50 writes must be successful. 
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5. INSTALLATION 

The installation steps are outlined below. Begin installation by making the necessary hardware connections. After 
installing the T600 hardware, install the software on the customer-supplied computer connected to the T600. Once 
you have installed the software, launch the software and perform the configuration procedures. 

System requirements for customer-supplied computer 

The customer-supplied computer must meet the following requirements in order to run the T600 software and 
successfully communicate with the T600 tag tester. 

Operating system:  Windows XP, Windows 7, Windows 8 /8.1 

COM ports:   two available RS-232 serial ports (DB9). 

USB ports:   one available USB port if using the hand-held bar code scanner. 

Installing the T600 hardware 

You need to connect the power cables to the TTU and the communication cables between the TTU and the customer-
supplied computer. If you have the optional hand-held bar code scanner, you need to connect it to the computer. 

Prerequisites: - Ensure a minimum of 10 ft. between TTUs. 
 - Ensure a minimum of 3 ft. between a TTU and a T500 Tag Programmer.  
 - Ensure a minimum of 1ft. between the TTU and OBUs not being tested. 

T600 connections 

 Connect one end of the serial null-modem cable to the HOST port on the back of the TTU. Connect the other end 
to a computer COM port.  

 Connect one end of the serial scanner cable to the SCANNER port on the back of the TTU. Connect the other end 
to a computer COM port.  

 Connect the TTU power supply to the AC outlet. Connect the power supply cable to the power connector on the 
back of the TTU.  

Optional hand-held bar code scanner connections 

 Connect and configure the hand-held bar code scanner as outlined in the manufacturer’s instructions (Symbol 
LS2208 Product Reference Guide, 72E-58808-07). 
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Installing the T600 software 

Install the software on the customer-supplied computer using the supplied CD. 

Prerequisites:  You need a computer that meets the system requirements (see ‘System requirements for customer-
supplied computer’, page 36). 

 Insert the T600 software CD in the PC CD drive. Follow the instructions provided by the InstallShield Wizard. If 
the InstallShield Wizard does not automatically launch, double-click the setup.exe file from the T600 software 
CD. 

 After the InstallShield Wizard welcome screen appears, and then click Next to proceed. 

 After reviewing the license agreement, select I accept the terms in the license agreement and then click Next. 

 Review the Readme Information and then click Next. 

 Enter a user name and organization name in the appropriate text boxes. 

 Under Install this application for, select Anyone who uses this computer so the T600 software can be accessed 
by all users. Click Next. 

 Select the destination folder where the software will be installed and then click Next. 

Note :  Instead of using the default folder  
     C:\Program Files (x86)\Kapsch TrafficCom IVHS\T600 Tag Tester <version>, 
     select  C:\Users\myUserName\Kapsch TrafficCom IVHS\T600 Tag Tester <version>  
     in order to have full control (read / write) permissions of folder & files. 

 Review the installation settings. Select Back to return to the previous installation steps and make changes as 
needed.  

 Click Install to begin installation. 

 After the installation is completed, click Finish to exit InstallShield Wizard. 

 Launch the T600 software as Administrator by right-clicking the executable T600TagTester.exe and select Run as 
administrator option. 

 Enter the TTU serial number. 

 Click Settings → Configuration. The Configuration Dialog window opens. 

 In the TTU Serial Number tab, enter the serial number found on the back of the TTU.  

 Click OK.  

The software installation is complete. 
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Constraints: 
Followings are only applied to Windows Vista and above with the installation folder under C:\Program Files (x86). 

Due to security feature User Account Control (UAC) introduced since Windows Vista, any non-Administrator 
program that tries to write to protected locations such as "Program Files" will get their writes caught and 
redirected to an alternative location, Virtual Store. 

Most programs in Windows including T600 do not run as an administrator even if you are signed into an admin 
account. 

In our case, if T600 attempts to write to files in folder eg. "C:\Program Files (x86)\Kapsch TrafficCom IVHS\T600 
Tag Tester 1.11.06.23" such as log files, the write will get redirected to 
"C:\Users\username\AppData\Local\VirtualStore\Program Files (x86)\Kapsch TrafficCom IVHS\T600 Tag Tester 
1.11.06.23". 

To avoid triggering the use of Windows Virtual Store, run T600 PC software as Administrator by right-clicking the 
executable T600TagTester.exe and select Run as administrator option. If necessary, use Windows Explorer to 
copy calibration files and agency mapping file to the T600 installation folder in C:\Program Files (x86). 

 

Installing the calibration files  

Optional calibration files, unique to each tag tester, may have been provided by Kapsch TrafficCom Canada Inc.. 
Installing these files provides the initial calibration of the T600. The IVHS installer must generate or obtain the OBU 
calibration files. They are not present on the supplied CD. 

Note: If you do not have the optional calibration files for the specific T600 you want to calibrate, contact Kapsch 
TrafficCom Canada Inc. to arrange calibration (see constraints in page 37 for copying the calibration files). 

Prerequisites: You must have a copy of the calibration files provided for the specific T600 tag tester. 

 Use Windows Explorer to copy the calibration files (*.CAL) into the folder created in: ‘Installing the T600 
software’, page 37, step 1. 

NOTE: It is possible to have calibration files for multiple tag testers in the same directory. The tag 
tester software identifies the correct calibration file based on the TTU serial number in the 
name of the calibration file. 

 Ensure that the serial number in the calibration file name matches the TTU serial number. 

 Launch T600 PC software as Administrator by right-clicking the executable T600TagTester.exe and 
select Run as administrator option. 

 Click Settings→Configuration. The Configuration Dialog window opens. 

 Ensure the number in the TTU Serial Number tab matches the number in the calibration file name. 

 If these numbers do not match, ensure you have the correct calibration file. If the file is correct, but 
the file name is wrong, rename the file with the correct TTU serial number. 
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Installing /Upgrading the agency mapping file 

The agency mapping file T600Cfg.xml included in the supplied CR-ROM /software package is installed when installing 
the T600 PC software. 

To install updates on the agency mapping file provided by Kapsch TrafficCom (see constraints in page 37), follow these 
steps. 

 Use Windows Explorer to copy the agency mapping file T600Cfg.xml into the installation folder created in 
Installing the T600 software on page 37. 

 Launch the T600 software as Administrator by right-clicking the executable T600TagTester.exe and  select Run as 
administrator option to have the new mapping file take effect. 

Note: User is advised NOT to modify the agency mapping file. Incorrect settings may cause improper function of the 
T600 Tag Tester. Contact Kapsch TrafficCom for new update on the file. 

Configuring the T600 tag tester communication settings 

You must configure communications between the customer-supplied computer and the TTU and its internal scanner 
before OBU testing begins. 

Prerequisites: - The T600 hardware and software is installed. 
 - You must know the COM port numbers of the computer serial ports which connect to the T600 

hardware. 
 

Configuring communications between the TTU and the computer 

 Click Settings→Configuration. The Configuration Dialog window opens. 

 Click on the Communications tab in the Configuration Dialog window. 

 Select the computer COM port that connects to the TTU HOST port from the T600 Comm. Port drop-down box.  

 Select 9600 from the T600 Baud Rate drop-down box. Click OK. 

 Ensure the computer COM port that connects to the TTU HOST port is set to 9600 bps. 

Configuring communications between the internal bar code scanner and the computer 

 Click Settings→Configuration. The Configuration Dialog window opens. 

 Click on the Communications tab in the Configuration Dialog window.  

 Select the computer COM port that connects to the TTU SCANNER port from the Scanner Comm. Port drop-down 
box. Click OK. 

 Exit and relaunch the T600 software for changes to take effect. 

 



 

T600 Tag Tester 

 

DOC#: UM 360420-835 REVISION F Page 40 of 55 

© Kapsch TrafficCom Canada Inc. 2022 
These drawings and specifications contain confidential and proprietary information and are the property of Kapsch TrafficCom Canada Inc. and are issued in strict confidence 
and will be kept confidential and used solely for the purpose intended and for no other purpose and shall not be transmitted, reproduced, copied, and/or used as the basis for 
manufacture or sale of apparatus unless otherwise agreed to in writing by Kapsch TrafficCom Canada Inc. 
 
FILE: UM 360420-835 REV F, T600 OPERATOR AND MAINTENANCE MANUAL.DOCX                                                                                                                     03/28/2022 3:02 

Kapsch TrafficCom 

ATTENTION: The following sections: 

• Agency mapping file configuration for tag types 

• How to identify interior OBU (G4E) from the older model FPT (G3B) 

• How to identify exterior OBU (FME) from the older model LPT 

apply to Kapsch service personnel.  

 

Agency mapping file configuration for tag types 

The new model Interior OBU (G4E) is used to replace the old model FPT (G3B) which shares the same type# 0  

The new model Exterior OBU (FME) is used to replace the old model LPT which shares the same type# 2. 

To identify the model of a tag, the tag serial number is used. 

The serial number ranges for the new models are specified in the agency mapping file T600Cfg.xml. If a tag serial 
number is not specified, the default is the old model. 

The following table lists the Tag types and their descriptions. 

 

Table 5-1: Tag Types Descriptions 

Tag Type  Name Type # Calibration File Remarks 

FTP G3B 0 T600 <s/n> FPT 
calibration history 
file.cal 

 

Exterior FTP RMT 1 T600 <s/n> Exterior 
FPT calibration 
history file.cal 

 

Interior OBU G4E 0 T600 <s/n> Interior 
OBU calibration 
history file.cal 

Replaces older 
model FPT (G3B). 
Identified by tag 
serial#. 

Feedback OBU  5 T600 <s/n> 
Feedback OBU 
calibration history 
file.cal 
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Tag Type  Name Type # Calibration File Remarks 

Exterior OBU FME 2 T600 <s/n> Exterior 
OBU calibration 
history file.cal 

Replaces older 
model LPT. 
Identified by tag 
serial#. 

Toll / Balance  3 T600 <s/n> Toll Tag 
calibration history 
file.cal 

 

HOT / HOV  6 T600 <s/n> HOT 
calibration history 
file.cal 

 

 

Note: It is required to specify the range of the tag serial# for the new model in the agency mapping file (T600Cfg.xml) 
in order for the application to pick the correct tag type and the required calibration file for testing. 

How to identify Interior OBU (G4E) from the older model FPT (G3B)  

Since the Interior OBU (G4E) and the older model FPT (G3B) share the same type# (0), use the tag serial number to 
differentiate them. 

 Open Microsoft WordPad. 

 In WordPad, open T600Cfg.xml. 

Note: T600Cfg.xml is located in the same directory as the executableT600TagTester.exe. 

 To specify the tag serial number range for G4E model, go to the appropriate Agency ID to make the changes. Refer 
to the Examples below. 

 On the line with Tag Model="G4E", change the field value of SerialNum_Start and SerialNum_End to the start and 
end of the tag serial number which are non-zero for the G4E model respectively.  

Note: If there are multiple serial number ranges, use multiple lines with each line specifying one number range. 
 Click Save in WordPad to save the file  

 Restart T600 application, T600TagTester.exe, for the new settings to take effect. 

Note: If the agency mapping file is not found, or corrupted when the application starts, a new file will be generated 
with “0” as the default value of SerialNum_Start and SerialNum_End for the G4E model for all agencies. This means 
that all tags with type# 0 will be identified as the old model FPT (G3B). 

How to identify Exterior OBU (FME) from the older model LPT  

Since the Exterior OBU (FME) and the older model LPT share the same type# (2), use the tag serial number to 
differentiate them. 
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 Open Microsoft WordPad. 

 In WordPad, open T600Cfg.xml. 

Note: T600Cfg.xml is located in the same directory as the executable T600TagTester.exe. 
 To specify the tag serial number range for FME model, go to the appropriate Agency ID to make the changes. Refer 

to the Examples below. 

 On the line with Tag Model="FME", change the field value of SerialNum_Start and SerialNum_End to the start 
and end of the tag serial number which are non-zero for the FME model respectively.  

Note: If there are multiple serial number ranges, use multiple lines with each line specifying one number range. 
 Click Save in WordPad to save the file  

 Restart T600 application, T600TagTester.exe, for the new settings to take effect. 

Note: If the agency mapping file is not found, or corrupted when the application starts, a new file will be generated 
with “0” as the default value of SerialNum_Start and SerialNum_End for the FME model for all agencies. This 
means that all tags with type# 2 will be identified as the old model LPT which is NOT supported in T600 and cannot 
be tested. 

 

Examples 

Example 1:  The default serial number range of “0” on both G4E and FME for agency "Kapsch" will have all tags of 
type#0 and type#2 identified as the old model, FPT (G3B)and LPT respectively. 

<Agency ID="0" Name="Kapsch"> 
<Tag Model="G4E" SerialNum_Start="0" SerialNum_End="0" /> 
<Tag Model="FME" SerialNum_Start="0" SerialNum_End="0" /> 
</Agency> 
 

Example 2:  Change serial number range to full range with start at “1” and end at “16777215” on both G4E and FME 
for agency "Kapsch" will have all tags of type#0 and type#2 identified as the new model, Interior OBU (G4E) and 
Exterior OBU (FME) respectively. 

<Agency ID="0" Name="Kapsch"> 
<Tag Model="G4E" SerialNum_Start="1" SerialNum_End="16777215" /> 
<Tag Model="FME" SerialNum_Start="1" SerialNum_End="16777215" /> 
</Agency> 
 

Example 3:   If serial number range for a particular model is not contiguous, specify the range start and end number. 
In the following example, 
FPT (G3B)                 :   1 - 99999, 200001 - 399999 
Interior OBU (G4E)    :   100000 - 200000, 400000 - 16777215 
LPT                            :   1 - 49999, 80001 - 89999 
Exterior OBU (FME)  :   50000 - 80000, 90000 - 16777215 

 
<Agency ID="0" Name="Kapsch"> 
<Tag Model="G4E" SerialNum_Start="100000" SerialNum_End="200000" /> 
<Tag Model="G4E" SerialNum_Start="400000" SerialNum_End="16777215" /> 
<Tag Model="FME" SerialNum_Start="50000" SerialNum_End="80000" /> 
<Tag Model="FME" SerialNum_Start="90000" SerialNum_End="16777215" /> 
</Agency> 
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6. TROUBLESHOOTING AND TESTING 

Troubleshooting trees are provided for resolving the most common T600 tag tester error messages. Because the T600 
is a tag tester, it is normal to receive tag failure messages. However, failures can also occur because of an issue with 
the TTU. Review this section to understand which errors are a valid result of an OBU failure and which are a result of 
an issue with the T600 tag tester itself. 

The error messages in Table 6-1 indicate OBU failures. Ensure the OBU is properly orientated in the TTU cradle before 
reporting a failed OBU. 

Table 6-1: Error Messages Indicating a Tag Failure 

Error Message Description 

No response from tag. There was no response from the OBU during testing, even at the 
highest signal level. 

Bad CRC transponder There were no good reads and more than half of the reads resulted 
in a bad CRC. 

Invalid tag Group ID The Group ID is not valid 

Bar code mismatch with tag 
contents 

The serial number and/or Agency ID stored in the OBU do not 
match the OBU bar code. 

Read margin exceeds limits The attenuation decrease required to read the OBU is below the 
acceptable range. 

Write margin exceeds limits The attenuation decrease required to write to the OBU is below the 
acceptable range. 

Read performance below limit The number of successful reads during the burst test is below the 
acceptable range. 

Write performance below limit The number of successful writes during the burst test is below the 
acceptable range. 
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Troubleshooting tree: Communications error - Check serial connection 

 
START

Symptom: 
Error message: Check serial 
connection between PC and T-600, 
T-600 power or the PC COM port.

 Inspect the cable and 
connections between 
the computer and the 

TTU HOST port.

Does the error 
message persist?

Contact Kapsch for 
Service Assistance.

Ensure the 
communication settings 
are properly configured.

Does the error 
message persist?

Ensure that the TTU 
power switch is in the 

on position.

The error is 
resolved.

The error is 
resolved.

Yes

No

Yes

No

Does the error 
message persist?

The error is 
resolved.

Yes

No
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Troubleshooting tree: Test Fail - Tag position failure (IR Beam) 

An Infra-Red(IR) sensor located in the TTU cradle detects when an OBU has been placed in the cradle.  

  

START
Symptom: 

Error message: Tag position failure 
(IR beam).

Check that the IR sensor  
beam is not blocked by 

any foreign objects.

Does the error 
message persist?

Contact Kapsch for 
Service Assistance.

Check that an OBU is 
properly positioned in 

the TTU cradle.

The error is 
resolved.

Yes

No

Does the error 
message persist?

The error is 
resolved.

Yes

No
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Troubleshooting tree: Tag Fail - Bar code mismatch with tag contents 

This mismatch error occurs when the Agency ID and/or serial number information stored in the OBU does not match 
that contained in the bar code information. The TTU antenna and internal bar code scanner are working properly; the 
problem is with the OBU. 

START
Symptom: 

Error message: Bar code mismatch 
with tag contents

Ensure the bar code  label 
is not obscured with dirt or 

damages. Retest the tag.

Does the error 
message persist?

Contact Kapsch for 
Service Assistance.

Test a known good 
OBU.

Does the error 
message persist?

Verify that the OBU is 
correctly positioned in 
the cradle. Retest the 

OBU.

The error is 
resolved.

Yes

No

Yes

No

Does the error 
message persist?

The error is 
resolved.

Yes

No

Retest the bad OBU.

Does the error 
message persist?

Yes

No The error is 
resolved.
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The internal TTU bar code scanner cannot read the OBU bar code 

An OBU can pass the tag test, even if its bar code was not read successfully. When this happens, an error message is 
not generated, but the Label Agency ID and Label Serial Number fields in the Bar code Data area display Unreadable. 

The TTU cannot read the OBU bar code or the OBU tag data 

If the TTU cannot read the OBU bar code or the OBU tag data, you are prompted to manually enter the bar code 
information (see ‘Entering the OBU bar code number’, page 22). You cannot proceed until a valid bar code number is 
entered. 

Resolving a missing calibration file error 

If the T600 attempts to test an OBU, and the T600 cannot locate a calibration file for that OBU type, the T600 displays 
this error message: This model can’t be tested, perhaps due to a missing calibration file. Check that the proper 
calibration file exists: 

 Click Calibrate.  

 Check that there is a calibration file listed for the OBU type you are trying to test.  

 If the OBU type is not listed, or the file type is marked with a red X and not a green checkmark, the calibration 
file cannot be located. 

To find a missing calibration file: 

 Note the TTU serial number. 

 Look in the folder containing the T600 files. Check all calibration files (*.cal). The correct calibration file will have 
the TTU serial number and tag type in the file name.  

 If the calibration file cannot be found, contact Kapsch TrafficCom Canada Inc. to have the T600 calibrated for 
that OBU type. 
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TTU functional check 

After 100 consecutive OBU tests that result in No response from tag, the Functional Check Requirement message 
window appears (see Figure 6-1). Perform the following procedure before contacting Kapsch TrafficCom Canada Inc.. 

Figure 6-1: The Functional Check Requirement message 

 
 

 Test a known good OBU.  

 If the known good tag passes the test and the functional check requirement message does not appear, the TTU is 
functioning properly. 

 If the functional check requirement message appears after testing the known good tag, test two additional 
known good tags. 

 If the functional check requirement message appears after testing three known good tags, create a new log file 
(see ‘Configuring log files’, page 25), change the text in the User/Comment box, then retest three known good 
tags. 

 If the functional check requirement message appears after retesting three known good tags, contact Kapsch 
TrafficCom Canada Inc.. 

Sending Log Files to Kapsch TrafficCom Canada Inc. 

The log files generated by the T600 contain important information about the tags tested. Kapsch may request theses 
log files to assist in troubleshooting. 

 Obtain a RMA number from Kapsch TrafficCom Canada Inc. 

 Rename the log file to include the RMA number.  

 Email the log file in its original format to Kapsch TrafficCom Canada Inc.  
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7. MAINTENANCE PROCEDURES 

Preventive maintenance procedures and scheduling 

Every four months: 

Using a vacuum, remove any loose contaminants from the OBU cradle. If necessary, use a slightly damp cloth to 
remove sticky grime.  

Every six months: 

Have the T600 tag tester calibrated. The T600 must only be calibrated by Kapsch TrafficCom Canada Inc. service 
personnel.  
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8. APPENDIX 

Note: Correct orientation of the G4 OBUs in the TTU cradle is in direction of the arrows. G4 OBU indicates the G4 
family (G4E, G4F, and G4P). 

G4 OBU Flat Pack Transponder (FPT)  Figure 8-1: G4 OBU Figure 8-2: Flat Pack Transponder (FPT) 
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Front Mount Exterior (FME) OBU 

 

Roof-Mount FPT 

  

Figure 8-3: Front Mount Exterior 
(FME) OBU 

Figure 8-4: Roof Mount FTP 
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Figure 8-6: High Occupancy Toll (HOT) OBU 

 
 
 

 
 
  

Figure 8-5: Front Mount OBU – 
Motorcycle 
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Reference documents 

Kapsch TrafficCom Canada Inc. documents 

PRO 360420-800  Product Requirement Outline – T600 Tag Tester 
TS 360420-810  Technical Specification – T600 Tag Tester 

Other commercial documents: 

72-71882-01 Rev. D LS2208 Quick Start Guide [English] 
72E-58808-07 Rev. A Symbol LS2208 Product Reference Guide 
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Accessing documentation 

You can access the documentation package for the T600 Tag Tester online at http://dds.kapsch.ca/ A Username and 
Password can be obtained from Kapsch TrafficCom Canada Inc. 

The documentation package includes: 

• Bill of Materials 

• Assembly Drawings 

• Schematic Drawings 

• Parts Specifications (for purchased items) 

• Operator and Maintenance Manuals 

• Installation Instructions 

• Software Design Documents (Context Diagrams, Data Flows, etc.) 

• As-built installation drawings (services) 

 
Acronyms  
 

Table 8-1: Acronyms  

Term Meaning Reference or example 

AC Alternating current  

bps bits per second a measure of baud rate 

COM communication COM ports 

CRC Cyclic Redundancy Check  

FME Front-Mount Exterior a type of OBU 

ID identification  

IR Infra-Red an infra-red beam is used by the proximity sensor to 
detect the presence of OBUs in the tag cradle. 

IVHS Intelligent Vehicle Highway 
System 

 

http://dds.kapsch.ca/


 

T600 Tag Tester 

 

DOC#: UM 360420-835 REVISION F Page 55 of 55 

© Kapsch TrafficCom Canada Inc. 2022 
These drawings and specifications contain confidential and proprietary information and are the property of Kapsch TrafficCom Canada Inc. and are issued in strict confidence 
and will be kept confidential and used solely for the purpose intended and for no other purpose and shall not be transmitted, reproduced, copied, and/or used as the basis for 
manufacture or sale of apparatus unless otherwise agreed to in writing by Kapsch TrafficCom Canada Inc. 
 
FILE: UM 360420-835 REV F, T600 OPERATOR AND MAINTENANCE MANUAL.DOCX                                                                                                                     03/28/2022 3:02 

Kapsch TrafficCom 

OBU On Board Unit a tag or transponder 

PDU Protocol Data Unit data passed over a network 

RMA Return Merchandise 
Authorization 

 

TTU Tag Tester Unit  

 
 


